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FCC Statement

Radio Interference Statement:

The WinTV USB have been tested and found to comply with the limits for a
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a resi-
dential installation. This equipment generates, uses, and can radiate radio fre-
quency energy and, cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or televi-
sion reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the
following measures:

• reorient or relocate the receiving antenna.           

• increase the separation between the equipment and receiver.        

• connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.                                            

• consult the dealer or an experienced radio/TV technician for help.

FCC  ID: H90WINCAST M A D E  I N  U S A 

CAUTION: Changes or modifications not expressly approved by the party
responsible for compliance to the FCC Rules could void the user’s authority to
operate the equipment.

CE Statement:
This equipment has been tested and complies with EN 55013, EN
55020 and IEC 801-3 part 3 standards.

CE
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Introduction

This manual covers all of the WinTV USB models:

WinTV-USB

WinTV-USB-FM

References to the WinTV USB apply to all models. The Windows98 driver for all
of the WinTV USB models will be referred to as the WinTV-USB driver, and
the installation CD-ROM will be referred to as the WinTV-USB Installation
CD-ROM.

The WinTV application, which is referred to in this manual as the WinTV appli-
cation, will show your TV or video in a window on your PC screen. There are
two versions: the WinTV32 and the WinTV2000. Both applications have the
same features, but have a different “look and feel”.

For models which have particular features (such as the chapter on the Radio
application), we will note which models these features are available on.

For a description of how the WinTV USB displays video on your VGA screen,
see the chapter entitled How WinTV-USB Works.
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Installing the WinTV-USB

N
ote: DO NOT PLUG THE WinTV-USB into your PC until

your PC has fully booted..

To install WinTV-USB under Windows XP, 98 or 2000, you will follow these
steps:

� Plug the WinTV-USB into your PC or laptop’s USB port (after booting into
Windows)

� Install the drivers from the WinTV-USB Installation CD-ROM

� After the WinTV-USB driver is installed, you will then install the WinTV
application software from the WinTV Installation CD-ROM

Contents of the WinTV-USB package:

WinTV-USB or WinTV-USB-FM unit

1 meter audio cable - sound cable for connecting between the WinTV-
USB and your sound card

S-Video to composite adapter

FM radio antenna (on WinTV-USB-FM models)

WinTV-USB Warranty registration card

WinTV-USB Installation CD-ROM with:
WinTV2000 application
WinTV driver for WindowsXP, 98SE, Me and Windows2000

WinTV-USB connections

The following chart shows the connectors of the WinTV-USB. 

FM: FM radio antenna connection (on some models)
TV: TV antenna or cable TV connection
LineOut: Audio output 1/8” minijack (connects to sound card LineIn jack)
S-Video In: S-video input from an external A/V source. Composite video can

be used via the S-Video to Composite adapter.
Line In: Audio input from an external A/V source (1/8” minijack)
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Installing the WinTV-USB

N
ote: DO NOT PLUG THE WinTV-USB into your PC until

your PC has fully booted..

Turn on and boot into WindowsXP, Windows98SE, WindowsMe, Windows 2000. 

Then plug the WinTV-USB into one of the USB connectors on the back of your
PC or laptop, not a USB hub or keyboard.

Installing the WinTV-USB driver for
Windows XP

After the WinTV-USB is plugged in to a USB socket, the Found New
Hardware Wizard will appear.

Click NEXT to Install the Software Automatically (Recommended).

1-2
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When you see this dialog box, insert the WinTV-USB Windows Installation CD-
ROM into your CD-ROM drive  and click NEXT.

If the the Hardware Installation dialog box appears, click 
Continue Anyway.

Click Finish to complete the driver installation.

WinTV-USB Installation and Reference Manual
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When the driver installation is complete, this message should appear on the
Windows start bar.

Installing the WinTV applications

After the WinTV-USB driver has been loaded, run the WinTV setup program.

Run SETUP.EXE from the WinTV-USB Installation CD-ROM. For example, if
your CD-ROM is on driver E:, click Start then Run then E:\Setup.exe

Click Install to start the WinTV installation.

Choose the language you would like and click OK.

Click Next / Next / Next.

After all of the files have been installed, you will see the Installation
Complete. Click OK.

Connecting the TV antenna and A/V cables

Connect a TV aerial or cable TV to the WinTV-USB connector marked TV.
If you have a WinTV-USB with FM radio, attach the supplied FM antenna to the
connector marked FM.

1-4
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You can also connect an A/V source such as a VCR, camcorder or video cam-
era to the WinTV-USB. Connect the video from your A/V source to the S-Video
In connector. If you have a composite video source, use the S-Video to
Composite adapter. Connect the audio from your A/V source to the WinTV-
USBs’ Line-In jack.

Connecting audio from WinTV-USB

There are two ways that audio gets into a PC or laptop from the WinTV-usb: 

- use the supplied 1 meter audio cable to bring analog audio from the WinTV-
USB into the Line-in jack on your PC or laptop, or 

- by using the USB cable to bring digital audio from the WinTV-usb to your
PC or laptop.

The default audio setting is: Analog audio input to the PC while watch-
ing live TV and Digital audio over USB while recording. This gives
the best audio quality.

If your PC or laptop computer has a sound card with a
Line-In audio connector:

Connect audio from WinTV-USB’s Line-Out jack to your sound card’s
Line-In jack. To do this, plug the supplied 1 meter audio cable into
the jack marked Line Out. Plug the other end into your PC’s sound card
LineIn jack.

If your PC or laptop does not have a Line-In connector:

You can enable Digital audio over USB while watching live TV. To do this,
see the section “Enabling live audio over USB”.

Enabling live audio over USB

After you complete the WinTV-USB driver
installation, the default Audio setting is:
Analog audio input to the PC while
watching live TV and Digital audio
over USB while recording. 

If your PC or laptop does not have a Line-in
jack, or if you would like to simplify the
installation of the WinTV-usb, you can
enable Digital audio while watching TV and

WinTV-USB Installation and Reference Manual
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while recording. To do this, click on the Menu button and go to Audio Type and
select Digital Rec+Live. 

Close and reopen the WinTV application to have the changes take
effect.

Connecting the WinTV-USB to a Sound Card

The WinTV-USB can supply audio over the USB bus. If you would like to connect
directly to a set of speakers, a headset, to a stereo system or directly to a sound
card, follow these instructions.

The  board's audio output can be connected using the supplied Audio Cable:

- plug one end of the supplied 1/8” Audio Cable into the jack marked
LineOut on the WinTV-USB.

- plug the other end of the Audio Cable into your speakers or headset, or a
soundcard’s LineIn jack. 

N
ote: Most sound cards have three round jacks on the outside of

the PC. They are: Microphone Input, Audio Output and Line

Input. The Audio Output would go to your speakers, while the

Microphone input might go to a microphone (if you are using one). The

LineIn jack is normally indicated on the sound card by the words IN or

LineIn stamped into the metal bracket on the outside of your PC. This

is where you would plug your  Audio Cable, Also Some Laptops do not

have a Line in and you would have to connect the  USB device to the

Mic input on the Laptop, or to a seperate set of powered speakers. 

Connecting the WinTV-USB to a VCR, Video
Camera or Camcorder

Most VCR’s or camcorders have a female RCA jack labeled “Video Out”. Most
also have a jack labeled “Audio Out”. Most video cameras simply have one out-
put connection labeled "Video Out". 

To connect the video to the WWiinnTTVV--UUSSBB, use shielded video cables (not supplied)

with male RCA connectors on both ends:

- connect from the “Video Out” jack on your video camera, VCR or cam-
corder to the S-Video input jack on the WinTV-USB. 

1-6
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N
ote:  WinTV-USB has a high quality S-Video input jack. If

your VCR or camcroder uses a Composite video connecot

(this is often a yellow RCA jack) , use the supplied S-Video

to Composite video Adapter.

To connect the audio from your VCR or camcorder, use  an 1/8” stereo minijack
extension cable (1/8” male minijacks on one  end, and RCA onthe other end) and
connect the “Audio Output” RCA  on the VCR or camcorder to the audio LineIn
jack on the WinTV-USB. 

N
ote: If  you need a female RCA to 1/8” minijack adapter, these

adapters can be found at most Radio Shack stores.

Adjusting the Audio Volume

If you are using bringing the audio from the WinTV-USB into your PC through
the “audio over USB” feature, or connecting to your Sound Card, the WinTV
application can change the audio volume coming from the WinTV-USB by
adjusting the LineInput sound volume of the Volume Control program
in Windows.

The Volume Control program is normally installed with Windows or by the
sound card installation program, and allows the control of volume from the vari-
ous sound sources. If you cannot hear sound when running the application,
check the volume level of LineInput in VolumeControl. The VolumeControl
application is started by either double clicking the speaker icon in
System tray (found normally in the lower right hand corner of your computer
screen), or clicking

Start/Programs/Accessories/Multimedia/VolumeControl

or

Start/Programs/Accessories/Entertainment/VolumeControl

WinTV-USB Installation and Reference Manual
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You should see Line-In balance as one of the selections. If not, then click on
Options/Properties and under Show the following volume controls
check Line-In. Then click OK.

You should now see a selection for Line-In Balance. Make sure the Select
box is checked, then raise the volume to about 1/2 of the way to the top. This
should be a good starting point for the volume control.

If Line-In is muted or not selected, unmute or select it to hear audio from
the WinTV USB.

In the WinTV application under the Configure/Audio menu (in WinTV200 click
on the AUD button), the Mixer ID should be set at Line-In. 

As you adjust the audio volume in the  application, you should see the slide bar
in the Volume Control window rise and fall.

Installing the  driver under Windows98 or
Windows2000

After the WinTV-USB is installed, the Add New Hardware Wizard will
appear.

Select Search for the best driver for your device (Recommended). 

Click NEXT.

When you see this dialog box, insert the WinTV USB Installation CD-ROM
into your CD-ROM drive. 
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Select CD-ROM drive and click NEXT.

Once the Hauppauge WinTV-USB driver has been detected, click NEXT.

You will see a number of files copied to your hard disk.

You might be asked to insert your Windows CD-ROM. Be sure to use the
exact version of Windows CD-ROM which is installed on your PC!

Click FINISH to exit to Windows.

N
ote: If Plug-n-Play does not correctly load the driver, you

may manually load the driver from the WinTV-USB

Installation CD-ROM. Open the USB folder and double

click the file “USB98.exe” to manually install the driver. 

Now you need to run the Setup program from the WinTV-USB Installation CD-
ROM. Either click on My Computer and select the CD-ROM drive where the
WinTV-USB Installation CD-ROM is inserted, and then double click on the
program Setup.EXE. Or you click on Start then Run and then type the letter
of your CD-ROM drive (for example: D:\) and SETUP.EXE

This will launch the WinTV-USB application and utilites installer.

WinTV-USB Installation and Reference Manual
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The WinTV2000 Application

Running the WinTV application

After installing the WinTV application from the WinTV USB Installation CD-
ROM, you will see  icons on your Windows background. Start WinTV-2000 or
WinTV-32 by double clicking on its icon.

Once the WinTV application is initialized, you should see the RED light illu-
minate on the WinTV USB.

You can also click on Start/Programs/HauppaugeWinTV and then click
on the WinTV2000 or WinTV32 icon.

The first time you run WinTV, you will be asked to scan for TV channels. Click
OK.

Freeze
Configure
snapshot

Software remote
control 

Color/Audio config-
uration

Preferences
menu

Remove toolbar

Full screen TV

Minimize Close WinTV

Switch video
source

Snapshot viewer window -
double click on each “thumbnail”

to see image full size
Current TV channel or

video source

Click your right mouse button here
to remove toolbars. Click again to

restore toolbar.

Click and hold your right mouse
button to see the Options menu.

Snapshot button

Channel configuration

Mute audio
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If you are using a cable TV connection, in the Broadcast/Cable menu item,
select Cable.

In Video Format, in North America choose NTSC M. In South
America, choose PAL M or PAL N.

After the scan is complete, you will have a list of TV channels which are active in
your area. 

You can modify the channel names by single clicking on the chan-
nel, then clicking Edit. Change the channel name to the name that you would
like to have displayed in the WinTV toolbar.

To set up a External video source,  go into Channel configuration (click on
Suite on the WinTV2000 or click Configure/Channels on WinTV-32),
and click on INPUT Sources. Highlight COMPOSITE and click ADD. Pick
your video format and give it a name, then click ADD. Now you have a external
video channel.  

2-2
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Video Capture with WinTV2000

Capturing both still images (BMP, GIF, JPEG etc) and motion videos (AVI) is sim-
ple with the WinTV-USB.  To configure and activate these functions, use the inte-
grated software remote control by clicking the RC button in the WinTV2000
application. WinTV32 has identical features, which can be selected from the still
camera and movie camera buttons provided on the top of the WinTV32 toolbar.

Snapshot Capture: Multiple still images can be captured, allowing you to
select or 
discard images and adjust the image size before saving.  Use the CFG but-
ton (below) to set the default image size (the image size can also be altered
by clicking the Right mouse button on a chosen image).

Motion Video Capture: The buttons under the Video Capture section are
numbered to aid clarity. 

First, click on 1. FILE to set the Name and Location of the file that you want
to create, for example: TEST.AVI in C:\ (as shown, we recommend adding
the .avi extension at the end of the file name).  

Click on FMT to set the Video Format, Frame Size and Frame Rate (typical-
ly: 15-bit RGB, 320x240 and 25 frames per second, respectively).

To start Recording, click on REC.  To stop Recording, click on REC again. 

A file name ending with the extension .AVI will be created and copied to your
hard disk.  To play back the recorded file, simply click on the PLAY button.
Alternatively, locate the file and double click on it.

Warning: Motion (avi) files can consume a large amount of disk space; typically
100MB per minute.

Setting up for audio capture: If you are using digital audio over the USB
bus, then you must configure the audio capture. Click and hold the right
mouse button on the WinTV window and you will see the drop down menu.
Click Record then Set Audio Source, and set Audio Capture Sources to

WinTV-USB Installation and Reference Manual
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Hauppauge WinTV-USB Pro Audio.

Note: If you find that there is no audio while playing back your AVI files, this is
because the sound card has not been setup to record audio from its 'Line-in'
socket.  To enable audio recording, open the Recording Control panel by click-
ing Start / Run and then 
SNDVOL32 /REC This will open the Recording Control panel. Make sure that
'Line-in' is enabled (this is sometimes called 'Line' or 'Aux').

Note: You can use AMCAP as an alternate to capture AVI files with WinTV-USB. The
program is called AMCAP on the WinTV-USB Installation CD-ROM, and can be
found in the MISC\UTILITY directory. This program will allow you to capture video
files in a Microsoft AVI file format to your hard disk. They can be played back to your
VGA screen by using Windows Media Player.

Using the mouse in WinTV

The Windows mouse is used to move the TV window, resize the window, select
menu options and make the  window appear in full screen or adjustable screen
size.  Use the left and right buttons, the middle mouse button (if your mouse has
one!) is not used.  

Single click TitleMode/NoTitleMode makes
easy to use!

The left mouse button is used for all control and select functions. The right
mouse button is clicked inside the video window to hide or display the tool
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and menu bars and to turn off the full screen TV mode.

These modes are called TitleMode and NoTitleMode. You can toggle back
and forth between TitleMode and NoTitleMode by simply clicking your right
mouse button when your mouse is inside the video window.

The WinTV window can be moved in NoTitleMode by clicking and holding
your left mouse button in the middle of the WinTV window and moving it to the
new position. Then let it go! 

Move the WinTV window in TitleMode by clicking and holding your mouse
button on the WinTV Title Bar, holding it down and dragging it to the new posi-
tion. 

You can set a different size and a different place on your VGA screen for the
WinTV window in TitleMode and NoTitleMode.  Then by simply clicking with
the right mouse button, the window will switch from one saved size and place
on the screen to the other! Try clicking your right mouse button several times in
the middle of the TV window and see what happens.

To set the window size, “grab” a corner of the WinTV window with your mouse
(hold down the left mouse button when it is on one of the corners of the  win-
dow) and then drag it to the preferred size, then release the mouse button.  

For example, if you would like to watch without the tool/menu bars in a small
corner of the Windows screen, click the right mouse button inside the video win-
dow and the tool/menu bars will disappear. Then drag the window to its pre-
ferred size and location on the Windows screen. Now click the right mouse but-
ton inside the  window and the  application will now save the correct size and
location on screen for NoTitleMode.  Every time you select the
NoTitleMode by right clicking in the  window, the window will resize and
move to the saved position.

With WinTV-32, you can select which bars and indicators are shown when in the
TitleBar and NoTitleBar modes by clicking on View. You can eliminate the sta-
tus bar and the toolbar in the TitleMode or add the status bar in the
NoTitleMode.  

Setting up your TV channels

To set up the TV channels with WinTV-32 in the application, click on
Configure/Channels/SuiteManager.

WinTV-USB Installation and Reference Manual
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In WinTV-2000, click the Suite button.

You’ll see the Channel Manager. From the Channel Manager, you can Add,
Edit or Delete channels.

You can also create Channel Suites, which are subsets of the All Channel
suite. For example, you can have a suite of just TV news channels, and name
this suite “News”. Channel Suites allow you to create a subset of all the chan-
nels, so that you can channel surf through only those channels. To set up a new
Channel Suite, click on Show Suites. Then click on Suites (in the left col-
umn), then click Add. You can then name the suite and add channels to
the suite.

To change to a suite, in the WinTV toolbar, right click your mouse button in the
Channel Suite area (the default is All Channels). You will then see a list of
suites. Click on the one you would like to switch to.
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Setting preferences in Title mode

Click Display/Preferences/View and then click on the Title Mode tab.

Aspect Ratio On forces the TV window height and width ratio to 4:3. When
turned off it will allow arbitrary aspect ratios.

Annunciators On display the TV channel on screen when you change chan-
nels, and display the volume when you adjust the volume.

Setting full screen TV mode

Click Display/Preferences/View and then click on the TV Mode tab.

WinTV-USB Installation and Reference Manual
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Set Allow Resolution Change. 

Once you have clicked on Allow Resolution Change, if you then click on the TV
icon on the WinTV-32 Toolbar, the WinTV will switch to full screen. 

Image Save, Print and Copy to Clipboard

The process to save, print or copy an image starts with the digitizing of a single
video frame. When one of these functions are clicked on,  the next video frame
is moved into your PC’s main system memory instead of the VGA display. Your
PC’s processor then converts the digitized video image into a 24-bit DIB image
(a format which is used internally in Windows), and then copied back into the
VGA memory so that you can see the image which will be printed or saved. This
becomes a “frozen” image in the  window.

The video images which are digitized can be saved to disk, printed to a color or
black/white printer or copied to the clipboard. These functions can be viewed
from the File menu:

There are a few things which need to be noted. First, because a video frame is
composed of two “fields”, an odd field with the odd lines in the image and an
even field composed of the even lines, there might be a distortion in the frozen
image if there was rapid motion while the image was being moved into main
system memory. This distortion is called “interlaced artifact”. 

Another item to note is that the video image, when converted into a 24-bit DIB
image, will look lighter than it did when it was in motion. You can adjust the
image’s brightness, contrast and color saturation and hue by clicking on
Configure/Color. These adjustments are made during the digitizing process on
the  board and will affect both the “live” image and the frozen image.
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Adjusting the video image’s color

You can adjust the brightness, contrast saturation and hue of the live TV image
by using the color adjustment menu. Click on Configure/Color to get the
adjustment menu:

Options Menu

The Options Menu has settings for Always-on-Top mode and Aspect ratio mode
plus duplicates buttons found on the toolbar for operation without a mouse.

Always-on-Top mode

The Always-on-Top mode conveniently puts the TV window “on top of” other
Windows windows. In this mode, you can easily move the TV window to the No-
Title mode by clicking the right mouse button in the middle of the TV screen.

Aspect ratio

The natural TV window size has a 4:3 aspect ratio. By unclicking the Aspect
Ratio setting in the Options menu, you can change the TV window to any size
you want! Make it tall, short or any size. With Aspect Ratio turned on, the win-
dow size will always be forced to a 4:3 ratio.

WinTV-USB Installation and Reference Manual
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Keyboard control of the WinTV application

Convenient keyboard controls duplicate the functions of the  toolbar.  
Volume Up = Page Up
Volume Down = Page Down
Mute = Ctrl+M
Channel Up     = Plus (+)
Channel Down = Minus (-)
Print a Frame = Ctrl+P
Copy to Clipboard = Ctrl+C
Copy from Clipboard = Ctrl+V
Freeze Frame = Ctrl+F
Full screen TV mode = Ctrl+T
Reset tool bar = Alt +M
Take a snapshot = Space bar
Right mouse button = Title mode/No title mode/Turns off TV mode

Setting up a shortcut

You can set up a shortcut to the  application at any time. To do this, click your
right mouse button on your Windows background. Then click on New. You
should see the following dialog box:

Then click on Shortcut. 

Click on Browse, then look in the Program Files/ directory. Select
WinTV 32.exe. 
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Then click on NEXT to finish to set up the shortcut.
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The WinTV32 application
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Still Frame Image Capture mode on WinTV32

With WinTV-32, you can switch into the high quality image capture mode by
clicking on the Still Frame Image Capture Mode button on the toolbar.
When you click on this button, you will see the Image Capture Toolbar.

Click on the Configure icon in the Image Capture Toolbar to set the image
capture resolution and to configure for either still or motion video images.

In WinTV2000, to configure still image capture, click on the CFG button
(found just above the Snapshot Viewer window). 

You can capture images up to 1600x1200 pixels. 

To reduce the effects of motion in the video image, but with lower image resolu-

WinTV-USB Installation and Reference Manual

2-13



tion, in the Fields Captured option choose 1 (Motion).

The WinTV-32 application

Motion Video Capture mode with WinTV32

You can switch the WinTV-32 application into the motion video capture mode by
clicking on the Motion Video Capture Mode button on the toolbar (see
page 2-2 for its location).

In WinTV-32, to configure motion image capture, click the 422/YUV (configura-
tion) button.

In WinTV-2000, to configure motion image capture, first open the software
remote control (click the RC button in the lower right hand corner of WinTV-
2000). Then click the Advanced Controls button (to roll down the
advanced controls), and then click the FMT button.
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For best performance when capturing, set the Image Format to YUY2 or
BTYUV, and the Image Dimensions to 320x240. Although you can cap-
ture larger than 320x240, the file size will be larger and the video capture quality
will be down graded.

The number of Frames per second captured (up to the limit of 30 fps) is set in
the File Folder icon in the Motion Video Capture toolbar, or by clicking the
FILE button in WinTV-2000.
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Creating Digital Video movies with
WinTV-USB

Using SoftPVR to record TV to your PC’s hard
disk

Note: The following functions are not currently enabled with SoftPVR: the OTP
and Pause buttons, plus the Fast Forward and Rewind functions.

Note: a Pentium III 800MHz minimum system is recommended for best SoftPVR
operation.

To start recording, either click the OTR (One Touch Record) or the red Record but-
ton on WinTV2000. You can also start a recording by using WinTV Scheduler.

To stop recording, click Stop. To close the recording controls, click the TV mode
button.

If you click OTR more than once, a record timer will be set and the record
timer will be set 15 minutes for each time the OTR button is clicked. For exam-
ple, if you click the OTR button 3 times, the WinTV will record for 30 minutes.

The recorded video file is saved in the DVCR Recorded File Path directory. To
set this directory, click the PREF button (Preferences menu), then the Movies tab.
In DVCR Record Path set the directory for your recordings.

Record Button: Clicking the Record button will automatically generate
a file name and start recording your audio/video program. Everytime

you record a file, a new file is automatically created and the file name is
displayed in the record window. The first file name will be _dvcr001.mpg.
The second file will be _dvcr002.mpg and so on.

While recording:

- Live video continues to play in the WinTV window
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- The Counter will display the length of your recording in hours:min-
utes:seconds

- If you had started recording with the OTR button, and had clicked it
more than once, the total time for the recording will also be
displayed. You can also click OTR after a record has been started, and
the record timer will be set. 

Click the Stop button to stop your recording. The recorded audio/video file is
then saved to disk using the automatically assigned file name. The Time counter
is reset to 00:00:00 after the recording is saved.

Play Button: Clicking the Play button will playback from disk the last
video file created. With SoftPVR, you can only Play and Pause your

videos.

File Button: Clicking the File button opens the File menu. The last file
recorded is listed in the File name box. In the File menu you can:

Rename your recorded video file, Play a video file previously recorded,
Delete recorded video files.

If you have problems with audio: 
If you find that there is no audio while playing back your AVI files, this is
because the sound card has not been setup to record audio from its 'Line-in'
socket.  To enable audio recording, open the Recording Control panel by
clicking Start / Run and then SNDVOL32 /REC This will open the Recording
Control panel. Make sure that 'Line-in' is enabled (this is sometimes called
'Line' or 'Aux').

Overview of WinTV Capture

Live video which is digitized by the  video digitizer (see “How WinTV USB
works”) can be “captured” as a video sequence (or “video clip”) by using the
WinTV Capture program. This program is provided in the WinTV Application and
uses Microsoft’s WDM for Windows capability which is built into Windows 98
and 2000.

WinTV-Capture creates a file type called AVI (Audio/Video Interleaved) on your
hard disk.  This file contains digitized video and, optionally, audio.

WinTV USB gives high quality captured video by storing uncompressed digi-
tized video in an AVI file. This compares with compression methods such as
JPEG and MPEG, where some loss of video quality is accepted in order to
reduce the amount of data stored. Uncompressed video capture creates high
quality digital video movies, but requires optimized system performance to
avoid lost video frames (called “dropped frames”.) 
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To create the best quality digital videos, use the following steps:

• Compress/Edit, etc. by using the appropriate 3rd party software with these
functions

• Edit the raw video.  Add special effects, cut, paste, etc. using one of the
popular digital video editing programs such as Adobe Premiere, MGI
VideoWave or U-Lead MediaStudio.

• After editing the video, compress the video for the playback target.  For
example, if you are creating a video to be used in a multimedia presenta-
tion, compress with either Intel’s Indeo or Supermac’s Cinepak.  If you are
creating a CD-Video, use MPEG compression to get up to 74 minutes of
video on a CD-ROM.

Using WinTV Capture

The WinTV-Capture program is an easy-to-use program that previews live
video, captures an AVI file to disk, and plays back the AVI file to your VGA
screen. WinTV-Capture can capture and playback video clips, but does not

provide video editing capabilities. Digital video editing programs such as Adobe
Premiere or U-Lead MediaStudio can be used to edit your digital videos.

With WinTV-Capture you can set the number of frames per second that are cap-
tured and the size of the video image. You need to experiment to determine how
much video your PC can store to the disk (in terms of image size and frames
per second) because capturing video clips is very CPU and hard disk intensive.

-Software Remote Capture window: Found in WinTV 2000
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Setting the video image size

The maximum suggested video image capture size is 320x240. When playing
back the video on slower PC’s, a smaller image size might be needed. To set
the image size, click on FMT Button:

The WinTV-Capture program can use several different types of color formats
when capturing video clips. For highest capture performance, choose the  YUY2
OR RGB formats. These give excellent capture image quality and frame rate,
but will give slow performance on playback of 320x240 image size videos. 

YUY2 OR RGB formats are also good if you plan to edit your video clips with
Adobe Premiere or MediaStudio, and plan to compress the digital videos using
Cinepak or Indeo. If you do not plan to edit your videos and want good play-
back performance, choose a smaller image size (160x120). Capture and play-
back performance is determined by your system configuration, including CPU
and hard disk speed.

Setting the number of frames per second captured

To set the number of frames per second captured, click on File/CaptureSetup:

The number of video buffers will depend upon how much RAM you have in your
system.  The maximum number of buffers is 1000.

After setting the video format, the number of frames per second and possibly
creating a new file name (by clicking on File/SetCaptureFile), you can start cap-
turing video by clicking on the Capture Video icon.
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Using Audio with WinTV-Capture 

To capture audio along with video, the WinTV USB must be connected to a
sound board capable of saving sound clips. To connect the USB to a sound
board do the following:  

a) Make sure the audio output of the  card is plugged into the LineInput of the
sound board. 

b) Make sure the LineInput volume for recording is set correctly and not
muted. Open the Volume control panel, then click on Options/Properties. In
the panel Adjust volume for recording set for Recording. Make sure
LineInput is checked under Show the following volume controls and that the
volume for LineInput is not muted and is set at an appropriate level.

Capturing audio along with video puts a greater

strain on your PC than capturing video alone. If your

PC drops many frames while capturing audio and

video together, then capture the audio separately with the audio

capture utility from Windows. The audio can be merged with

video later on during the video edit stage.

Suggestions on capturing video

Captured image sizes can be either 160x120 or 320x240 pixels.

For the best trade off between image size and captured frames per second,  use
a 320 x 240 image.  With a 166MHz processor MMX (or better) and a reasonably
fast hard disk drive, you should be able to capture 30 frames per second using
the  YUY2 OR RGB format.
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The consumption of hard disk space is dependent upon the size of the video
image while capturing, the image format plus the number of frames/second.
Using the  YUY2 OR RGB image format, the following chart shows hard disk
space consumed:

image size frames/second bytes per second 1 minute video

160x120 15 frames/sec 425 Kbytes/sec 26 Mbytes

320x240 15 frames/sec 850 Kbytes/sec 52 Mbytes

320x240 30 frames/sec 1.7  Mbytes/sec 104 Mbytes

Video consumes quite a bit of hard disk space! At 320x240, you will only be
able to store about 10 minutes of video on a 1 Gigabyte hard disk!

To reduce the amount of hard disk space used by your digital videos, you can
edit the video using one of the popular 32-bit digital video editors (such as
Adobe’s Premiere or U-Lead’s MediaStudio). After editing, you can compress
the video using a software playback format such as Indeo or Cinepak (both of
these are supported by Windows98). Typical compression achieved by these
formats is 30:1.

Tips on improving capture performance

Do not use DoubleSpace or any other disk compression scheme! This severely
slows down your hard disk.

Turn off screen savers and do not connect to a local area network.

Most professionals capture video and audio separately.  This allows them to “lay
down” the audio track on top of the video tracks while editing. Capturing video
separately will increase the performance of your video captures.

There are several hard disks on the market which are designed for higher per-
formance video captures.  These drives use 1:1 interleaving and track caching
to eliminate gaps caused by a hard disk drive seeking to the next track. They
are available with both IDE and SCSI interfaces.
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Teletext Data Reception using VTPlus    (In
Europe ONLY)

Teletext is used in Europe and other parts of the world to transmit digital data
along with a television picture.  Teletext data is transmitted in an invisible part of
the TV picture called the "Vertical Blanking Interval" or VBI. 

Teletext data is normally formatted into pages. A master index is also transmit-
ted which lists the various categories that can be received, and which Teletext
page they are being transmitted on. Teletext data must be inserted into the VBI
by your TV broadcaster, and can only be received on the WinTV USB if the
Hauppauge Teletext decoder is installed.

An example of a Teletext page follows. Each Teletext page has a page number, a
date and the current time in the right hand corner:(The time shown in a selected
page will only Update if “Update Continuosly is selected- see later, in this
section).

VTPlus for WinTV USB is a sophisticated Teletext software application which
runs exclusively on the Hauppauge WinTV. VTPlus allows you to view multiple
Teletext pages, save or print Teletext pages and create Dynamic Data Links so
that Teletext data can be used in other Windows applications. The WinTV appli-
cation does not have to be active while the VTPlus Teletext application is run-
ning. 
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Starting VTPlus

If the VTPlus application is provided on CD-ROM, then it will automatically be
installed from the  WinTV-USB Installation CD-ROM.

To start VTPlus, click on the VTPlus button in WinTV32 or click on the
TELE button in WinTV2000. This will close the TV application and launch
VTPlus. The WinTV USB cannot run the application and VTPlus at the same
time.

You need to create a VTPLUS suite within the WinTV 32 or WinTV 2000 applica-
tions. Go to ConfigureChannels, Suite manager, Suites and choose
ADD suite and name the new suite “VTPLUS”.

Configuring VTPlus

The first time that you run VTPlus, it is recommended that you first check the fol-
lowing configuration setting:

Go to Options, Program options, and make sure that in the General tab,
Multiple Channel Mode is selected but not Background Memory Active. If
Background Memory Active is selected and greyed out then, temporarily, you
will need to de-select the Multiple Channel Mode option.
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VTPlus toolbar

*Note: These functions are not applicable in the UK.

1. Reception indicator: when this symbol is red, your requested page is
being received. 

2. Script: shortcut for Options/Script. See Help for information on program-
ming the Script.

3. Select previous Subpage: indicates, when dark, that there are sub-
pages before the current subpage. When a light grey, there are no sub-
pages before the current page. 

4. Select next Subpage: indicates, when dark, that there are subpages
after the current subpage. When light grey, there are no subpages after the
current page.  For example, if the current page is 100 and there are no sub-
pages in page 100, the Select next Subpage icon will be light grey.

5. Reveal button: shortcut for Show/HiddenCharacters. When you use this
button you might see hidden text, such as VPS time codes or answers from
a Quiz. 
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Quickselect Teletext pages

By using the Ctrl+N key a Create and Receive page pops up requesting a page
number. Type the requested page number. If this page is to be received continu-
ously (every time the page is received, the page is automatically updated), click
the Update Continuously box.

Many Teletext pages have a reference to other pages. For example, the TV
guide section has a number of page referrals to movie background information
which is being transmitted in other pages. Quickselect allows you to select
these pages directly. Double click the left mouse button on the desired page
number in the current Teletext page, and a new Window appears with the select-
ed page.

If you do not want to open a new Window, but simply change to the new page,
push the Shift-Key while double-clicking on the page number in the current
Teletext page, and the new selected page will appear in the original window.

With Quickselect, several pages can be called at once. If a Teletext page refers
to a page sequence such as “Share Prices: 500-505”, mark the first page num-
ber with a single mouse click, click a page number and start the reception with
a left Doubleclick on the end page. The distance between the selected pages
must not be more than 11.

Example: “News from Page 300-303” are selected with by a single click on 300
and a Doubleclick on 303. The multiple page reception will open individual win-
dows for each of the pages within the selected page numbers.

Dynamic Data Exchange with Teletext

DDE links can be created between the Teletext pages and any Windows pro-
gram supporting DDE.  Programs supporting a live DDE link from a Teletext
page include the Microsoft EXCEL spreadsheet and Microsoft WORD.

To create a link, use your mouse to highlight the section of the Teletext page of
interest.  For example, if the current Teletext page has financial data, highlight
with the mouse the financial item of interest by click on the beginning of the field
on the Teletext page, holding your mouse button down, and releasing the
mouse button at the end of the field.
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Then click on Edit/Copy option from the Edit menu and click the left
mouse button. The information is now in the PC memory. To create a link to
the DDE supported applications (such as your spreadsheet), select “edit past
special” in your application and choose the past link option. VTPlus will now
create a direct link to your program.

When the data changes in the selected field on the Teletext page, VTPlus will
deliver the data automatically to your DDE supported program. Updates
through the DDE occur when all subpages are being received and at every
update, when the option Update Continuously is marked.

N
ote: For DDE to operate it is necessary for the VTPlus pro-

gram to be running and for the specific page to be shown.
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Using the Radio Application

If you have purchased the WinTV-USB-FM, in addition to watching TV you can
also tune in radio stations on the FM band. 

The radio device has two aerial inputs, one for TV and one for FM radio. If your
TV antenna (or cable TV network) carries both TV and FM radio, you can con-
nect to the TV antenna connector only:

Running the Radio Application

Click on Start / Programs / Hauppauge WinTV and then Radio to run the radio
application. 

The radio window

Using the Radio Buttons

Volume: The audio volume is adjusted by setting the LineIn level in the
Volume Control applet.

Tune: Fine tune the current radio channel.

Seek: Search for the next active FM radio channel.
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Mem: Sets a FM radio channel preset. To assign the current station to a
preset, click on Mem and then on one of the Preset buttons (1-10).

Mute: Turn off the sound.

Mono: Force mono reception.

Scan: Searches for new stations until you click on Stop. Click the RIGHT
mouse button anywhere on the -radio window to set the Scan mode. 

Min: Minimizes the -radio window.

CD: Starts the Audio CD-Player for playing back Audio-CD´s.

TV: Closes the radio application and starts the  application.

OFF: Closes the radio application.

1 - 10: Preset 1 - 10

Programming the Presets

To assign a radio station to a special Preset button do the following:

1. Tune in the desired station with the Seek button (or by using Tune).

2. Click on the Mem button. It will change to red.

3. Click on one of the Preset buttons (1-10).

Using the right Mouse button

When you click the RIGHT mouse button in the -radio window, this menu comes
up:
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1. Scan Mode: Presets - When Presets is chosen and the Scan button is
clicked, -radio tunes in only the stations which are assigned to the Preset
buttons.

2. Scan Mode: All - When All is chosen and the Scan button is clicked, -
radio tunes in all radio stations.

3. Frequencies: A list of all frequencies assigned to the preset buttons is
shown.

4. Tool Tips: Turn on/off bubble help.

5. Minimize: Minimizes the -radio application window.
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How WinTV-USB Works

Your WinTV-USB contains a 125 channel cable ready TV tuner, a video digitizer,
a video compression engine and a USB bus controller. WinTV-USB displays
video and audio in the following way:

Under software control, the WinTV-USB either tunes to a TV channel or selects
the external audio/video input source. 

The audio from the chosen source is passed to the LineOut jack on the WinTV-
USB. In some cases, the audio is digitaized and compressed, and sent over the
USB bus along with the video to the PC.

The video from the selected source is digitized inside the WinTV-USB device
and compressed. The compressed video is sent by the WinTV-USB device over
the USB cable into your PC.

Once the compressed video is in your PC, the WinTV-USB software driver
decompresses the video and sends a reconstituted frame to your graphics dis-
play adapter 30 times each second (25 times per second in Europe and other
PAL areas). 

Your graphics display adapter then resizes the video image to fill the window
size that you have chosen for the WinTV window.

Typically, you will use the supplied audio cable to carry the audio signal from
the LineOut jack on the WinTV-USB to the LineIn jack on your sound subsys-
tem. Your sound subsystem will then mix this signal with other audio sources
before driving your speakers.

Since the decompression of video images is done by software, a processor with
MMX is required. The actual rate at which the frames are decompressed
depends on the clock speed of your processor, and on whether it is doing any
other "big" jobs, such as rendering complex web pages.

The USB datarate of the compressed video is a maximum of 7.5Mbits/sec. If
there are other devices on the USB bus, and these devices are using some of
the USB “bus bandwidth”, the WinTV-USB device cuts the datarate down so that
the  USB “bus bandwidth” can be shared at a maximum rate of 7.5Mbits/sec.
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Troubleshooting

This chapter includes troubleshooting help for solving common problems.

Problem: Bad colors in the TV window

If your VGA display is running in 256 color mode, the TV picture will be dis-
played with only 256 colors. This compares with the 16 million different colors
which are in the original TV image. The colors in the TV window will change
depending upon which Windows programs are being run, and what color
palettes are being used.

To fix this problem, first try running your VGA adapter at a minimum of 16 bits
per pixel. If you do not have enough memory on your VGA adapter to run at 16
bits per pixel in the current resolution, either lower the resolution (example: from
1024x768 to 800x600) or add more VGA memory to your VGA display adapter.

Error message: “could not find "ksclock.dll" or other
files on the WIN98 CD”

Be sure that the directory is correct where windows is looking. Your cd rom
drive(D:\ for example). in some cases D:\win98 if the windows 98 files are locat-
ed on your harddrive(preinstalled on the system), it should be looking for c:\win-
dows\options\cabs 

Error message: “error code 69 during installation of
drivers.”

Cancel and browse the  CD rom. double click on the USB98.EXE file located in
the WIN98 Folder. after installing, the system will reboot.

System locks or does not shut down correctly with the
USB pluged in:

Look in your systems BIOS for Legacy USB support and set it to ENABLED. A
bios update may be necessary if this setting is not present.

Problem: Poor TV picture quality

A poor TV image could be caused if your VGA display adapter does not have
enough video RAM to hold the TV image. In this case,  resorts to Primary
Surface mode, which lowers image quality. A memory upgrade on your VGA
display adapter might fix this problem.

Another possible cause of this problem could be that your VGA display adapter
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does not support Windows 98 Direct Draw. In this case, you might consider an
upgrade to a new Windows VGA accelerator which has Direct Draw support and
is compatible with the  USB.

A poor video picture might also indicate a bad signal. To verify a bad signal, try
one or more of these:

Move your antenna or check your cable connection.

Move possible interference sources, such as other computers or television sets,
away from your PC.

Contact the cable company to check your signal quality.

Problem: TV picture displays a black screen

The TV picture might display a black screen under the following conditions:

Momentary loss of signal

A weak video signal

Channel changing

A scrambled channel

Changing channels may cause a temporary black

screen. To fix the problem, switch the channel up or

down, then return to the original channel.

The  audio might continue to broadcast, even though the video picture displays
a black screen. This indicates a strong audio signal and a weak video signal.

A scrambled channel is not a valid channel:  Set Primary.exe to DIBDRAW
Mode!

Problem: Snapshots don't display correctly

When using a 256 color palette, snapshots display incorrectly. To correct the
problem, try one or both of these:

Change your Windows color palette to 16-bit.

Copy the image to a graphics program and save the image as a 24-bit
image.

Primary Surface mode & DIB Draw

It is sometimes useful to use a mode of operation of your VGA card known as
Primary Surface mode or DIB Draw. This can be helpful in eliminating VGA com-
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patibility problems, or improving picture quality on some VGA boards when
used in some resolutions.

To use Primary Surface mode, run the program "PRIMARY", which is installed
with the WinTV application. Click Start/ Programs/WinTV and then, Click on
Primary. Click on Force Primary or DIB Draw then close the program by clicking
on the X. The Primary program simply makes a setting in the Windows Registry
that tells the  application to use the Primary mode  or DIB Draw mode of opera-
tion. 

This can be changed at any time to "Allow Overlay" by re-running Primary and
clicking Allow Overlay or DIB Draw.
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Updating the WinTV-USB driver

From time to time, there might be a new WinTV USB driver which is an improve-
ment over the existing driver. Driver updates can be downloaded from the
Hauppauge Internet Web site (see the front page of this manual for the URL).

The WinTV USB update is combined with the driver uninstaller and the driver
installer. Once you have downloaded the updated WinTV USB driver, you can
install the update simply by running the downloaded program. You will see the
following message:

Click Next.
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Click Next.

The  Update program now uninstalls the existing WinTV-USB driver, then copies
a number of files to your hard disk:

After the  Driver installation program has copied all of the files over to your disk
drive, you will be asked to reboot:

Click OK to reboot your PC.

After rebooting Windows98, an automatic installation of the new  driver takes
place. You will see the New hardware Found message. After installing a new
driver, it is advisable to install the latest applications, including the
WinTV32,WinTV2000 and the radio  applications (if your  board has these fea-
tures).

Removing the  driver with HCWCLEAR

On occasion, it might be necessary to remove all traces of the  driver on your
PC’s hard disk. To do this, there is a program on the  Installation CD-ROM called
HCWCLEAR. 

The HCWCLEAR application can be found in the MISC/UTILITY directory:  
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Run HCWCLEAR by double clicking on its icon:

Click OK.

You will then see the following message:

Click Yes.

If there are any errors which come up during the running of HCWCLEAR, then it
means that there is an application running which is using the  drivers. For exam-
ple, if you see the following error:
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it means that one of the WinTV USB driver files in use . You can either ignore the
error, or can can double check to make sure there are no applications running
in the system that might be using the WinTV USB driver. In general, to make
sure the re-installation is done correctly, all applications using the WinTV USB
driver should be stopped before HCWCLEAR is run.
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Technical Support

Technical support telephone 

If you have questions regarding installation or compatibility, please contact our
technical support staff at:

(631) 434-3197

(631) 434-3198   Fax

USB FAQ-URL:

http://www.hauppauge.com/html/faqusb.htm

Service 

If you should need assistance with the installation, operation, or application of
your Hauppauge WinTV USB, there are several options available to you. Your
primary source for information and problem assistance is always your dealer.
Should the need arise, contact your dealer for on-site or repair service. 

Hauppauge’s Technical Support and Customer Service staff can aid in solving
many problems.  Our service department is available to repair any Hauppauge
product.  For completion of repair, the product must be returned to our factory. 

If this WinTV USB is not in working order, your only recourse is repair or replace-
ment, as described above. UNDER NO CIRCUMSTANCES will Hauppauge be
liable for consequential damages, including any lost savings, lost profits, or any
other damages, caused by the use of the WinTV USB or inability to use it, even
if the dealer or Hauppauge has been advised of such liability or other claims.
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The Hauppauge Limited Warranty

Warranty 

Hauppauge Computer Works, Inc. warrants the WinTV USB to be free from
defects in material and workmanship for a period of 2 years from date of initial
retail purchase.  We will, at our option, repair or replace a defective product. The
limited warranty does not cover any losses or damage that occur as a result of: 

• Improper installation 

• Misuse or neglect or operation with faulty equipment 

• Repair or modification by anyone other than Hauppauge Computer Works
or an authorized repair agent

Please complete and return the Warranty Registration Form  inserted in this
manual. To obtain service under this warranty, contact Hauppauge Computer
works at (631) 434-3197, or fax “RMA Department” at 631-434-3198.  Please see
the return procedure in the “Technical Support” chapter. 
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